IFAP and Schools Portal Content Management
Functional Processes and Procedures

Department of Education
Financial Student Assistance (FSA)
Content Management
Functional Processes & Procedures

March 2002



IFAP and Schools Portal Content Management

Functional Processes and Procedures

DOCUMENT HISTORY

This shows updates that have been made to this document.

Author Date Version Description
Oct-00 1.0 Initial Release

Lisa Phillips/Josh 11-Oct-01 2.0 Updates made to reflect Interwoven

Stauffer upgrade

Mark Mandrella 31-Oct-01 3.0 Updates made to reflect Interwoven
upgrade and grammar changes

Mark Mandrella 26-Dec-01 3.1 Updates made to reflect Marcello’s
comments

Lisa Phillips 28-Mar-02 3.2 Updates made to reflect Marcello’s

comments and additional notes from Mark
and Dorothy

IFAP Portals Content Management Processes V3.0.doc

Status: Final

Page 2

Last Updated:4/25/2002
Version 2.0




IFAP and Schools Portal Content Management
Functional Processes and Procedures

Table of Contents:

1.0 INTRODUCTION. .. .ettiiiittiiteiititte ettt ettt e ettt e e s sttt e e s st b e e e s abbe e e e s abbeeeeaabbeeeesabbeeeesabbeeeesabbeeeesanbeeeenns 5
BACKGROUND .....ciutittateaste et et saeasteasteesbeeeeaeesaeeeaeaaseabeeaseeaseeheeeheeab e e abe e e e eaee£aeeeheebe e b e embeeabesheesbeesbeeaseannesanesnns 5
VVHAT ISVWEB CONTENT? .ettiteitesueasteateeseessesaeesseessessseasssasesaeasseanseaaseaasesaeesseesbeeabeaasesaeesanesaeanbeanbeeasesnsassnesaeas 5
WHAT ISWEB CONTENT MANAGEMENT? ....ceuietiiteietestenestestesestestesestestenessestesessestenessestenessestenessessenessessenessensenens 6
FSA WEB CONTENT MANAGEMENT PROCESS ARCHITECTURE. .....cutittietertereetesteseesestesessesseseesessesessessesessessessesens 6

High Level (Tier 1) Web Content Management Process ArchiteCture ...........coooccvveeeeeeeieniciiineeenn. 6
Detailed (Tier 2) Web Content Management Process ArchiteCture..........cccccovvviiiiieeeeeeieniciiiieeenn. 7
Process Workflow Diagram LEGENG...........oeii ittt e e e e e e eeeee e s 9

1.1 CONTENT CREATION PROCESS (RECOMMENDED)........ccttiiiiiieeiiiiieesiieee e ssieeeessiieeae s 10
1.1.1 ADD CONTENT TO | FAP/SCHOOLS PORTAL (RECOMMENDED) .....couiiiiieiteieeseesieeeeeeseesee e e e eneeneeneas 10
1.1.2 MODIFY EXISTING CONTENT ON IFAP/SCHOOLS PORTAL (RECOMMENDED) .....coeeieeeierieseeseeseeneeneenens 12

1.2 CONTENT MANAGEMENT PROCESSES .......coiiitiiiiiiiiie ettt e e nineee e 14
1.2.1 PRIORITIZE AND ASSIGN JOBS....c.ueiitteiteeiteeietaeeaueesueasseasseasesssesssessesssesssesasssasssasssuessseassesnsessessssssssssessses 14
1.2.2 PROCESS CONTENT . .eitteuteeuteaueasueesueasueaasesaseaeesaeasaeasseaaseaaseassesseeaseessesasesasesasssasssaeesaeaaseansesnsesnsesasesseessens 17
1.2.3 REVIEW AND APPROVE CONTENT ...tiuiitiiteietesteseetestesessestesessestesessestesessestesessessenessessenessessenessessenessessenens 20

1.3 CONTENT DELIVERY PROGCESSES ......coiiiitiiie it esiiete ettt et ee e siteee e stteee e s snneeaesnnnenaeans 23
1.3.1 DELIVER AND DISTRIBUTE TO PRODUCTION ...c.veuiitiiteietesteneetestesestestesessestesessessenessessenessessenessessenessessenens 23

2.0 TEAMSITE FUNCTIONAL PROCEDURES ........oottiiititieiiiie ettt sntae et e e 25
QUICK TIPSAND TACTICS ..uettrteeetesteseetesteseesesteseesesseseesesseseesesseseesestessesessessesessessesessessesessessesessessesessessesessensasens 25

Getting the LateSt CONTENT ..........eeiiiiie ettt e e e e e e et e e e e e e e e e annbbeeeeeae e e e annneees 25
Editing HYPerlinks iN WOTA ........oooiie ittt e e e e e et e e e e e e s snrraeeeee s 25
Schools Portal Links File and Contact Page.........cccuviiiiiiie et 25
Adding Attachments t0 DOCUMENES ........cuiiiiiiiiiiiieiie e e e e e e e e s s e e e e e e e s e e e e e e e e snrraneeeeeas 25

N F= o] To TR0 o \VZ=T o1 i oo N I o1 T 26
BrOWSEI SEING TIPS tvvvteeeiiiiiiiiiiieeeesisitie e e e e e e s st eae e e e e e s s s s tbaeeeeeeeesaasastaaeeaaeesaasntaneeaeeessannnrsaneeees 26
ALCCESSING TEAMSITE ... tieitieitte ettt et sie ettt et saeeshe e s be e s be e aee e aee s ae e saeeebeeabeameeeabeeaeeeh e e aheesbeebeaaeesanesaeasseanbeenseans 27
[WoTo o laTo l T a1t T NCT: Ty 4 ST (= U UR TSP 28
SEttiNg YOUr HOME PAJE ....eiiiiiiiiiiieieie ettt ettt e e e e e e st e e e e e e e e e sbbbbeeeaaaeeaanns 29
COMPLETING TASKS. .. .eettteeetesteseetesteseetesteseesesteseesesteseesesteseesesbeseebesbeseesesbeseebesbeseebesbeneebesbeneebenbeneebenbeseesenbeneenens 30
Creating @ JOb iN the TO DO LISt.....ciiiiiiiiieiiei et e e e e e e 31
Viewing Tasks / JODS iN the TO DO LISt ....cciuiiiiiiiiiiieeee e 32
Changing the Owner of Tasks / JObS in the TO DO LiSt.........ccccviiiiieeiiiiiieeece e 34
CreatiNng @ NEW TaASK....uuiiiie it e e e e e s e e e e e s e en e ee e e e e e e s aansstrereeeeesannnnneens 35

T 11 ] o 1= 36
Importing/Editing Files and Content Not in TEAMSITE™ .........uuiiiiieiiiiiieiie e 38
Create a NeW Data RECON .........uiiiiiiiiiiiiiee ettt e et ee e e st e e e nnbae e e e enees 40
Viewing Comments From An AUthor OF HIGNET ........coiiii i 42
LOCKING AND UNLOCKING FILESUSING SUBMIT LOCKING. ....ciueeetiriereetesieestesiesestestenessesieessesteessessenesseseenenns 43
][ To 141 g To T 1 (=TT 45
APPROVING / REJECTING AND DELETING CONTENT ...cuttiuirtirteestesteessestesessessessssessessesessessesessessesessessesessessenens 46
P Y o] o] (o)Al To [ O e] o1 (=] o | PP 47
][ 1] o B @] 1 (= o | SRR 48
Removing Files from WOIKAr€a..........ouueeiiiie e 49
RemoVvINg FIleS frOmM StAgiNg . ..ueeiieiii it e s e e e e e s s r e e e e e s snnraaeeeees 50
.0 DEFINITIONS ..ttt ettt ettt e sttt e e sttt e e s sttt e e ean b et e e e nbb e e e enbbeeeeanbbeeeeanbbeeeeaneee 51

IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002

Status: Final Page 3 Version 2.0



IFAP and Schools Portal Content Management
Functional Processes and Procedures

4.0 USING WEBDESK ....cooiiiiiiiiiiiiiiiee ettt ettt ettt et et e et e et et e e et et et e et e et e e e e e e eeee et e tee et eeeeeeeeeeeeeeeeeees 54
LOGQING INTO TEAMSILEA ......eeeeeiiiiieiiiiete ettt e e e e ettt e e e e e e e e bbb b e e e e e e e e e aannbraeeaaeas 54

RN oA gV T = ] ST N o o 1P 54
VIBWING WOTKBIBAS ....ceeiiiiiiieiiiee e ettt ettt e e e e e e ettt e e e e e e s bbb et e e e e e e e e aanbbabeeeaaeeeeaannbnneeaaans 55
MISCEIIANEOUS [TEIMIS ... e ettt e e aaaabaaa e ae s tassaaaasasasasnsssssasnsssnsssnsnsnsnnnsnnnnnnns 55

IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002

Status: Final Page 4 Version 2.0



IFAP and Schools Portal Content Management
Functional Processes and Procedures

1.0 Introduction
Background

Until recently, most enterprises used web channels only as a means to disseminate relatively static (stable and
uniform) information. Today’s enterprises are building highly dynamic sites where content is not only updated on
a daily basis, but often changing in real-time using highly complex sites. Enterprises in today’s high tech economy
are facing both growing traffic and volume at online sites; and as a result, there is significant growth in the amount
of content contained by their websites. In general, the aging methods and techniques for maintaining online
content are time-consuming, costly and inefficient. There was a growing need to enable businesses to update
and maintain content in a more direct and timely fashion causing a rise in demand for specialized content
management processes and applications.

The intent of this document is to present a comprehensive, integrated view of web content management. We will
introduce the working definitions of the terms “web content” and “web content management”, and describe the
various types of web content and the key content characteristics that apply to FSA. The process for IFAP and
Schools Portal web content management will be discussed at high-level and then broken down into specific roles,
tasks, and procedures. Finally, we will focus on Interwoven’s TeamSited , and how this web content management
tool will be used to enable FSA’s web content management process.

What is Web Content?

Web content can be made very simple. It can be an icon, a headline, a publication, audio tracks, video film clips
or news updates. Web content is collectively the text, audio/video, graphics, and applications that comprise the
end-user’s total experience online. For the working definition we’ll define web content as any discrete
component that can be stored digitally, managed as a piece of meaningful content and distributed to one or more
web based channels. The content for the FSA’s Schools Portal and Information for Financial Aid Professionals
(IFAP) are in the form of news updates, headlines, calendar events, publications, policies and procedures. The
Web Shop (Schools Channel Customer Service Call Center/ IFAP-SP team) will utilize the content management
software (Interwoven’s TeamSited ) and content development tools (such as Dreamweaver, Word, etc.) to
manage and deliver the content from the business unit to the web shop to publication on the server.

IFAP web content is primarily static content containing text files and graphics. IFAP content includes FSA
headlines and publications.

The Schools Portal web content is primarily static content containing text files and graphics. Content on the
Schools Portal includes FSA headlines, a calendar of events, and links to several FSA websites.

IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002
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What is Web Content Management?

Web content management is a set of tasks and processes that manages the addition, revision, and deletion of
the content targeted for publication on the web from the content’s creation to archiving. The content
management workflow is the set of actions that take the content through development to production. This is the
system for defining the necessary steps for creation and approval. The content management workflow includes
user tasks and a variety of automated tasks.

FSA Web Content Management Process Architecture

High Level (Tier 1) Web Content Management Process Architecture

FSA’s web content management processes are based on the premise that there will be a centralized web shop to
manage the content posted to IFAP and the Schools Portal. The Tier 1 Web Content Management Process
Architecture contains three core processes: Content Creation, Content Management and Content Delivery.
Interwoven’s TeamSited software technically enables these processes by providing a flexible and scalable
solution for managing web content.

1.3 Content
Delivery

1.2 Content
Management

1.1 Content

Creation

Figure 1 — High Level (Tier 1) Web Content Management Architecture
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Detailed (Tier 2) Web Content Management Process Architecture

The Tier 2 view of the Web Content Management processes provides a detailed view of how an idea for content
gets published to either IFAP or the Schools Portal. ‘Designated’ Content Managers and the Schools Channel

Customer Service Call Center will use these processes on a daily basis.

1.1.1 Add
Content to
IFAP/Schools
Portal

1.2.1 Modify 1.2.2 Prioritze
Existing and Assign
Content Jobs

1.2.3 Develop
Content

Expedite
Content

1.2.4 Review
and Approve

Figure 2 — Detailed (Tier 2) Web Content Management Architecture

1.3.1 Deliver
and Distribute

Content
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Ref. # Process Description Responsibility/ Tools Outcomes
Process Owner

1.1. Content Creation — This process defines the Designated Content Content idea
actions to be undertaken by the designated Content creation tools formulated,
Content Managers within the FSA business Managers within | such as Word, | documented
units. ldeas are formulated within the business | the FSA business | Excel, and forwarded
units by Content Contributors. The Content units PowerPoint via email to the
Contributor documents his/her idea in the and HTML Schools
appropriate format for the Content Manager in editor tools and | Customer
his/her business unit. Each business unit has Interwoven Service Call
a Content Manager who will review and TeamSitea Center
approve the content and send an email request
to the Schools Channel Customer Service Call
Center. The Content Manager provides a
description of the work to be done and
attaches any necessary files to the email.

1.2 Content Management — This process defines | Schools Channel | Interwoven Content is
the actions to manage content once it has Customer TeamSitea prioritized and
been received by the Schools Channel Service Call jobs are
Customer Service Call Center. Center created within
The Schools Channel Customer Service Call IFAP/Portal Interwoven.
Center IFAP/Portal coordinator reviews the coordinator and
email request, creates a job in Interwoven, and | staff Jobs are
assigns the job to an IFAP/Portal Team assigned and
Member. A workarea for the job is also content is
selected. The Schools Channel Customer created via
Service Call Center staff view the assigned job Interwoven
and develop the content via an Interwoven templates.
template. Once the content is created, a
different member of the Schools Channel A quality review
Customer Service Call Center will perform a is performed;
quality review of the content and approve the content is
content. The review also ensures that it approved and
conforms to FSA style guide, usability, and submitted to
accessibility guidelines. The content is then the staging
deployed to the staging area within Interwoven area within
where it is ready for deployment to the IFAP Interwoven.
and/or Schools Portal web server and
database.

1.3 Content Delivery — This process defines the Schools Interwoven New edition of
actions to be undertaken by the Schools Customer TeamSitea , IFAP and/or
Channel Customer Service Call Center Service Call Open Deploy Schools Portal
IFAP/Portal team with support from the Center and Data deployed to the
IFAP/Schools Portal Applications Management | IFAP/Portal team | Deploy. production
team and Virtual Data Center (VDC). The member, server and
Schools Channel Customer Service Call IFAP/Portal database
Center IFAP/Portal team member conducts a Applications
final review of the entire site (within the staging | Management
area) prior to publishing a new edition of IFAP | team, and Virtual
or the Schools Portal. Then, the Schools Data Center
Customer Service Call Center IFAP/Portal
team member deploys the new content to the
production server and related database.
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Process Workflow Diagram Legend

The following pages include detailed process workflow diagrams for the web content management processes.

Listed below is a legend of symbols that will be used to illustrate these processes.

Start

Stop

Swim Lane 1

A task box defines the
Task Box what task needs to be
performed

Yes
No

A decision box poses a

Decision Box ’
Yes-No question.

A process circle defines the
process that precedes or
follows a task

Process

Circle

Swim Lane 2

A swim lane provides the function that will perform
that tasks within the 'swim lane'

Interwoven TeamSite is

I-I _
used for the task

Interwoven
TeamSite
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1.1 Content Creation Process (Recommended)

The content creation process defines the recommended actions to be undertaken by the designated Content
Managers within the FSA business units. Ideas are formulated within the business units by Content Contributors.
The Content Contributor documents his/her idea in the appropriate format for the Content Managerl in his/her
business unit. Each business unit has a Content Manager who will review and approve the content and send an
email request to the Schools Channel Customer Service Call Center. The Content Manager or the designee
provides a description of the work to be done and attaches any necessary files to the email.

1.1.1 Add Content to IFAP/Schools Portal (Recommended)

This process defines the actions to be undertaken by Content Contributors and Content Managers. Authorizers
within the business unit request the addition of new content to IFAP and/or the Schools Portal. This process is
used for new content that is being added to IFAP and/or the Schools Portal for the first time.

1.1.1 Add Content to IFAP/Schools Portal Process Workflow

Content Contributor Content Manager
No
1 2 3 4
ety Document e Yes | Saquesttor
Start > new_c(izontent » new_((j:ontent the Schools content
idea idea Portal? addition

Develop
Content

1 CSCC Maintains alist of Content Managers to approve content for publication to the IFAP and Schools Portal web site.
Individualsinterested in being added to the list must have their manager, who is aready on the list, request that they be added
and at what capacity.

IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002
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1.1.1 Add Content to IFAP/Schools Portal Process Workflow Description

Step # Step Description | Responsibility |  Tools Outcomes
Start

1. Identify New Content Idea — The Content Content N/A Content idea
Contributor identifies information or has an | Contributor within formulated
idea that is relevant for posting on IFAP an FSA business
and/or the Schools Portal. unit

2. Document New Content Idea — The Content | Content Microsoft Content idea
Contributor documents the content idea Contributor within | Office suite of | created
within the appropriate tool. This step takes | an FSA business | tools or FSA
it from idea to content documented in a tool. | unit standard
It is forwarded to the Content Manager for HTML editor
review.

3. Is it Appropriate for IFAP and/or the Content Manager | N/A Content idea
Schools Portal? — This is a checkpoint to reviewed and
make sure the right information is going to approved
the right audience at the right time.

Grammar, spelling and accuracy are also
checked at this point.

If (Yes) — The process continues on with
step 4.

If (No) — The Content Manager
communicates the required changes and
the process goes back to step 2

4. Send an E-mail Request for Content Content Manager | FSA emalil E-mail request
Addition — The Content Manager within submitted to
each channel who is responsible for Schools Channel
pushing all new content to the content shop Customer Service
sends an E-mail request with a description Call Center
of the work to be done and attaches any
necessary files. This request is sent to the
Schools Channel Customer Service Call
Center.

Stop
IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002
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1.1.2 Modify Existing Content on IFAP/Schools Portal (Recommended)

This process defines the actions to be undertaken by Content Contributors and Content Managers to modify
existing IFAP and/or Schools Portal content.

) FSA

T ELA
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1.1.2 Modify Existing Content on IFAP/Schools Portal Process Workflow

Identify
Start conten_t that

< > requires
modification

Content Contributor

No

2

A

Specify

A,

modifications

S it appropriate

Portal?

Yes

Content Manager

4

Send E-mail
L» request to

necessary ——»< for IFAP/Schools

modify content

h 4

Prioritize
and Assign
Jobs
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1.1.2 Modify Existing Content on IFAP/Schools Portal Process Workflow

Description
Step # Step Description | Responsibility | Tools |  Outcomes
Start
1. Identify Content That Requires Modification | Content N/A IFAP/Schools
— The Content Contributor periodically Contributor within Portal content that
reviews his/her content on IFAP/Schools an FSA business requires
Portal to determine if content is inaccurate unit modification
or outdated®. The Content Contributor identified
identifies information that requires
modifications.
2. Specify necessary modifications — The Content Microsoft Specific
Content Contributor modifies the existing Contributor within | Office suite of | modifications
IFAP/Schools Portal content and forwards it | an FSA business | tools or FSA documented
to the Content Manager for review. unit standard
HTML editor
3. Is it Appropriate for IFAP/Schools Portal? — | Content N/A Modified content
This is a checkpoint to make sure that this Manager/ reviewed and
is the right information going to the right Authorizer approved
audience at the right time. Grammar,
spelling and accuracy are also checked at
this point.
If (Yes) — The process continues on with
step 4.
If (No) — The Content Manager
communicates the required changes and
the process goes back to step 2
4, Send an E-mail Request for Content Content E-mail request
Modification — The Content Manager within | Manager/ submitted to
each channel sends an E-mail request with | Authorizer Schools Channel
a description of the work to be modified and Customer Service
attaches any necessary files. This request Call Center
is sent to the Schools Channel Customer
Service Call Center.
Stop
2 Outdated datais usually placed in the archive area of IFAP.
IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002
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1.2 Content Management Processes

This process defines the actions to manage content once it has been received by the Schools Channel Customer
Service Call Center. The Schools Channel Customer Service Call Center content coordinator reviews the E-mail
request, saves3 all electronic documents, formats a job in Interwoven, and assigns the job to a IFAP/Portal team
member. A workarea for the job is also selected. The Schools Channel Customer Service Call Center
IFAP/Portal team member views the assigned job and processes the content via an Interwoven template. Once
the content is formatted, a different IFAP/Portal team member of the Schools Channel Customer Service Call
Center will perform a quality review of the content and approve the content. The review also ensures that it
conforms to FSA Style Guide, usability and accessibility guidelines. The content is then migrated to the staging
area within Interwoven where it is ready for deployment to the IFAP and/or Schools Portal web server.

Content management processes include modifying existing content on IFAP/Schools Portal, removing obsolete
content from IFAP/Schools Portal, prioritizing and assigning jobs, processing content for IFAP/Schools Portal, and
reviewing and approving content.

1.2.1 Prioritize and Assign Jobs

This process defines the actions to be undertaken by the Schools Channel Customer Service Call Center
IFAP/Portal coordinator to receive email requests from Content Managers, prioritize these requests and assign
the requests to the IFAP/Portal Team Member.

1.2.1 Prioritize and Assign Jobs Process Workflow

Schools Channel Customer Service Call Center IFAP/Portal Lead

Add Conte

to IFAP/
Schools
Portal

N View E-mail
requests

Réquest withir
scope of
JeamSite?

Create job in

—{ Prioritize jobs —» Assign jobs —
Interwoven

Yes - Save E——

2a No
Modify v - — - —
Existin .
Conten% Consult with Interwoven Interwoven Interwoven Develop
IFAP/SP TeamSite TeamSite TeamsSite Content
Manager

S

—— Paper
Shared s
Drive

Remove
Obsolete
Content

3 All original files are saved to the CSCC shared drive.
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1.2.1 Prioritize and Assign Jobs Process Workflow Description

Step # Step Description | Responsibility | Tools |  Outcomes
Start

1. View E-mail requests — The Schools Schools Channel | ED E-mail E-mail requests
Channel Customer Service Call Center Customer reviewed
IFAP/Portal Coordinator reviews email Service Call
requests and attachments from Content Center
Managers. IFAP/Portal

Coordinator

2. Is the request within the scope of TeamSite | Schools Channel
or will it require processing by the IFAP/ SP | Customer
Application management team? Service Call

Center
If (Yes) — The process continues on to step | IFAP/Portal
3. Coordinator
If (No) — The process continues on to step
2a.

2a. Consult with IFAP/SP manager/lead for Schools Channel Job Assigned to
procedures to assign a task to the IFAP/ SP | Customer IFAP/SP
Application Management team. Then stop. Service Call Application

Center Management team
IFAP/Portal
Coordinator

3. Save — the Schools Channel Customer Schools Channel | EDNET Library maintained
Service Call Center IFAP/Portal Coordinator | Customer
will save and/or file electronic and paper Service Call
documents to their respective areas. Center
Electronic files are saved to CSCC'’s shared | IFAP/Portal
drive. Paper documents are filed in Coordinator
CSCC's library.

4. Create Jobs in Interwoven — The Schools Schools Channel | Interwoven Interwoven job
Channel Customer Service Call Center Customer TeamSitea created
IFAP/Portal Coordinator logs onto Service Call
Interwoven TeamSite and creates a job for | Center
the request. IFAP/Portal

Coordinator

5. Prioritize the job — The Schools Channel Schools Channel | Interwoven Job prioritized
Customer Service Call Center IFAP/Portal Customer TeamSitea
Coordinator identifies the priority for the job | Service Call
in the Comments. Center

IFAP/Portal
Coordinator

6. Assign the job - The Schools Channel Schools Channel | Interwoven Job assigned to
Customer Service Call Center IFAP/Portal Customer TeamSitea staff member
Coordinator assigns the job to a Schools Service Call
Channel Customer Service Call Center staff | Center
member. IFAP/Portal

Coordinator
IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002
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Step # Step Description | Responsibility | Tools |  Outcomes
Stop
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1.2.2 Process Content
This process defines the actions to be undertaken by the Schools Channel Customer Service Call Center staff to

develop content.

1.2.2 Process Content Workflow

Prioritize and
Assign Jobs

Schools Channel Customer Service Call Center Branch Staff Member

1

.| View jobs in

the 'To Do' list

2

Select a job to

»!

- —

e
Interwoven
TeamSite

work

—_—

————
Interwoven
TeamSite

Modify
Existing
Content?

5a

Modify Content
Added by

Create Content
Via New Data
Record

S
Interwoven
TeamSite

Modify Content
on TeamSite

Is Content

»

-

Interwoven
TeamSite

Okay?

Yes

v

Complete Job

Stop

Review and
Approve
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IFAP and Schools Portal Content Management
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1.2.2 Process Content Workflow Description

Step # Step Description | Responsibility |  Tools Outcomes
Start
1. View Jobs in the ‘To Do’ List — The Schools Schools Channel Interwoven ‘To Do’ list
Channel Customer Service Call Center Customer Service | TeamSited reviewed
IFAP/Portal team member reviews jobs in Call Center
his/her “To Do’ list. IFAP/Portal team
2. Select a Job to Work — The Schools Channel | Schools Channel Interwoven Job selected
Customer Service Call Center IFAP/Portal Customer Service | TeamSitea
team member selects a job to work based on | Call Center
priority entered by the IFAP/Portal IFAP/Portal team
coordinator in the Comments.
3. Is the Job to Modify Existing Content? Schools Channel Interwoven
Customer Service | TeamSitea
If (yes) go to step 4 Call Center
If (no) go to step 6 IFAP/Portal team
4, Does the content exist within TeamSite? Schools Channel Interwoven
Customer Service | TeamSitea
If (yes) go to step 5 Call Center
If (no) go to step 5a? IFAP/Portal team
5. Modify content on TeamSite Schools Channel Interwoven Content modified
- Add files to be modified to a job. Customer Service | TeamSitea
- Edit the files. Call Center
- Gotostep7 IFAP/Portal team
5a. Modify content not on TeamSite Schools Channel HTML Editing
- Download the files from the web. Customer Service | Tool,
- Import files to TeamSite. Call Center Interwoven
- Edit the files. IFAP/Portal team TeamSite™
- Gotostep7
6. Create Content Via a New Data Record” Schools Channel Interwoven Content created
(Template) - The Schools Channel Customer | Customer Service | TeamSitea
Service Call Center IFAP/Portal team Call Center
member enters the content provided in the IFAP/Portal team
appropriate template and saves this record.

4 CSCC maintains field descriptions of all fields for all template types. In the future these descriptions will be added to this
document as an appendix.
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Step # Step Description Responsibility Tools Outcomes
7. Is Content Okay? - The Schools Channel Schools Channel Interwoven Content reviewed
Customer Service Call Center IFAP/Portal Customer Service | TeamSitea
team member previews the content and Call Center
reviews it to ensure that it is accurate IFAP/Portal team
(grammar, spelling and content) and the
presentation is correct.
If (Yes) — The process continues on with step
8
If (No) The process reverts back to step 3
and the appropriate changes are made
8. Complete Job - The Schools Channel Schools Channel Interwoven Job completed
Customer Service Call Center IFAP/Portal Customer Service | TeamSited
team member indicates the job is done and Call Center
provides any necessary comments for the IFAP/Portal team
reviewer.
Stop
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1.2.3 Review and Approve Content

This process defines the actions to be undertaken by the Schools Channel Customer Service Call Center
IFAP/Portal team member to review and approve content and submit content to staging.

1.2.3 Review and Approve Process Workflow

Develop

Schools Channel Customer
Service Call Center Branch
Staff

Schools Channel
Customer Service Call
Center Branch IFAP/
Portal Lead

Content Manager/Authorizer

Content

Approve
Content?

=

\_/
Interwoven
TeamSite

Content
manager
review

eeded?

Approve Yes
Content?

4 v

Submit to

staging

S —
Interwoven
TeamSite

S
Interwoven
TeamSite

Deliver and
Distribute to
Production
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1.2.3 Review and Approve Content Process Workflow Description

Step #

Step Description

| Responsibility |

Tools

|  Outcomes

Start

Approve Content? — The content is assigned
to the Schools Channel Customer Service
Call Center staff for review to determine if it
is consistent with FSA design standards and
accessibility guidelines.

If (Yes) — The process continues on with step
2.

If (No) — The Schools Channel Customer
Service Call Center IFAP/Portal team
member communicates needed changes and
the process goes back to the 1.1 Content
Creation.

Schools Channel
Customer Service
Call Center
IFAP/Portal team

Interwoven
TeamSitea

Content reviewed

Content Manager Review Needed? — Based
on the type of content, the Schools Channel
Customer Service Call Center IFAP/Portal
coordinator will determine if the content
needs to be previewed in a test environment
(i.e. IFAP development server) for review
and approval by the Content Manager who
submitted the content. Also make sure that
step by step procedures are added to the 2.0
Fuctional Procedures of how to add content
to IFAP development server and supply the
URL of where the document can be found.

If (Yes) — The process continues on with step
3.

If (No) — The process skips step 3 and
proceeds to step 4.

Schools Channel
Customer Service
Call Center
IFAP/Portal team

Interwoven
TeamSitea

Decision
regarding
whether the
Content Manager
needs to approve
the content

Approve Content? — The content is reviewed
by the Content Manager/ Authorizer to
determine if the content should be authorized
for production.

If (Yes) — The process continues on with step
4,

If (No) — The Content Manager/ Authorizer
communicates needed changes and the
process goes back to the Develop Content
process.

Content Manager

Interwoven
TeamSitea

Content reviewed
and approved by
Content Manager

Submit to Staging — The Schools Channel
Customer Service Call Center IFAP/Portal
team member submits the content to the
TeamSited staging area where the entire
site resides as a read-only copy.

Schools Channel
Customer Service
Call Center Staff
IFAP/Portal team

Interwoven
TeamSitea

Content
submitted to
staging
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Step # Step Description | Responsibility | Tools | Outcomes
Stop
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1.3 Content Delivery Processes

The Schools Channel Customer Service Call Center IFAP/Portal coordinator (with an administrator TeamSited
role) will deploy the site to the production server using Interwoven Open Deploy and to the production database
using Data Deploy.

1.3.1 Deliver and Distribute to Production

This process defines the actions to be undertaken by the Schools Channel Customer Service Call Center
IFAP/Portal coordinator to deliver and distribute new content of IFAP and/or the Schools Portal to production.
Users can view the new content.

1.3.1 Deliver and Distribute to Production Process Workflow

Schools Channel Customer Service Call Center Branch IFAP/Portal Lead

< > | Publish .| Deploy to ‘< >
Start New Edition Production Stop
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1.3.1 Deliver and Distribute to Production Process Workflow Description

Step # Step Description | Responsibility | Tools | Outcomes
Start

1. Publish New Edition — After the content has Schools Channel Interwoven New edition of
been submitted to staging, the Schools Customer Service | TeamSited IFAP and/or the
Channel Customer Service Call Center Call Center Schools Portal
IFAP/Portal coordinator publishes a new IFAP/Portal created
edition of IFAP and/or the Schools Portal. coordinator
[Are new editions needed? if not please
remove from this step.

2. Deploy to Production — The new edition of Schools Channel Interwoven New edition of
IFAP and/or the Schools Portal is deployed Customer Service | Open Deploy | IFAP and/or the
to the production server using Interwoven Call Center and Data Schools Portal
Open Deploy and production database using | IFAP/Portal Deploy deployed to the
Data Deploy. This can be a manual or coordinator production server
automated process. What is the automated and database.
process please provide details?

Available for
viewing by users
Stop
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2.0 TeamSite Functional Procedures

Quick Tips and Tactics

This section lists various “tips” that users may find helpful when using the TeamSite& application:

Getting the Latest Content

» After identifying which content is needed (e.g. Schools Portal Calendar, Direct Loan Bulletin, etc.)
determine where in the directory structure the content is stored.

» All Schools Portal content (excluding sfalinks) is located in the following directory:
/templatedata/sp/content_type/data

» For each IFAP publication type content is located in two directories:
/publication_type
/templatedata/(ifap or loan)/publication_type/data

» To update the directories check the box next to the directory and press the Get Latest button in the
button bar. This will update the selected directories with the latest files from the staging area.
Remember that both directories must be updated to ensure good data for all IFAP publications.

» Follow the Editing a Publication already in TeamSite procedure, which was previously distributed.

Editing Hyperlinks in Word

» Once a file is open in word highlight the link text. From the Insert menu select HyperLink. Enter the
fully qualified path (e.g. http://www.ifap.gov) into the top field and press OK.
» This can be used to create new hyperlinks or edit existing ones.

Schools Portal Links File and Contact Page

» Content is stored in following directory:
/HTMLDocs

» Files exist under this directory named sfalinks and contacts.htm, and edit the HTML page is needed
for the sfalinks page and Contact Page.

» Inform Accenture DBA to update the fsa_links table in the Schools Portal database, so fsa links
update can be propagated to the customer's "My FSA" pages and the "Customize MY FSA Links"
personalization feature.

Adding Attachments to Documents

» Templates for all IFAP publications contain a section that allows the users to add attachments to the
HTML file. Attachment files must be saved in the attachments directory under the corresponding
HTML file directory in the users workarea.

» Two fields must be filled out to complete the attachment, label and link. Label is the highlighted text
on the HTML page that the website user will click to get to the attachment. Link is the path to the
attachment.

» To properly populate the link field press the browse button and select the appropriate file from the list.
Only the files listed in that publications attachment directory will be listed.

» If more than one attachment is required, press the Add Attachments/Enclosures button and another
label/link pair of field will be placed on the template. Repeat as necessary.

» Remember to include all attachment files into the workflow of the publication. The attachments will
not be deployed to the website unless they are bundled with the publication.
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Naming Convention Tips

When entering a date, the format should be yyyy-mm-dd unless otherwise specified by the
description.

When creating file names please do not use special characters, dashes or spaces in the file
name

Interwoven is case sensitive. Make sure that, when entering file or branch information, you
remember to match the case in the name you type and the actual file/branch name.

Browser Setting Tips

Make sure your internet browser is set to refresh each time a page is visited. To do this in
Internet Explorer, go to Tools—> Internet Options. On the “General” tab, under “temporary internet
files,” select “settings” and select “every visit to the page.” Press the OK button. In order for the
settings to take effect, you must close your browser and restart it.
The link to the IFAP development site is http://test.ifap.ed.gov:8532.
The link to the IFAP test site is http://dev.ifap.ed.gov:8531.
The link to the Schools Portal test site is http://actest.schoolportal.ed.gov:8182
To determine how long it will take to download a file using a 56k modem please refer to the
formula below: (This formula is useful for those files that are very large)

o (File size in Kilobytes x 10)/56 = time in seconds to download on a 56k modem.

o If the result is greater than 60, divide it by 60 to get time in minutes.
Compress large files for download by using Winzip.
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Accessing TeamSite

SFA Employee IFAP/Portal Team
Logs Into P Sets their Home
TeamSite Page

Section 2.0 will cover the first step of using Interwoven’s TeamSited Application Software. In this section,
you will learn how to log on to TeamSite and Set up your Home Page. When logging into TeamSitea for
the first time, LaunchPad will automatically download and install on your local computer. LaunchPad is a
small helper application that resides on you local computer, which allows you to make associations
between file types and the editing applications you use. It's totally transparent to the user; you don’t have
to do anything.

Note — the first time a user creates or edits a Data Content Record (DCR), the Visual Format program will
install on the user’'s machine. The Visual Format tool will allow rich text formatting within a designated
field within the data capture template
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Logging Into TeamSite

IFAP/Portal Team
Logs Into
TeamSite

These procedures are written for users with Microsoft Internet Explorer Browsers. Other browsers, like
Netscape browsers, may be used. However, additional steps may need to be performed due to
differences in functionality. Following the entire sequences will reduce any uncertainty while executing
the procedural steps for browsers other than Internet Explorer.

IFAP/Portal team Logs - Click your TeamSite/Browser Icon from your desktop

into TeamSite for - From the Login as pull-down menu, select your user type (i.e.
Content Management author, editor, or administrator)

Tasks. - Enter your Username in the Username field

Enter your Password in the Password field

Check the WebDesk box if you want to use the WebDesk
interface (for Authors only)

Click the Login button.

To log out of TeamSited , press the Logout button located in
the lower left-hand corner of the screen. You will be returned to
the Login screen.

For WebDesk Users:
From the Login screen, enter your Username, Password, and
select Author as your “Login as” type.
Check the WebDesk checkbox and press the Login button.

Note: The first time you log into TeamSite& , the Launch Pad application will automatically be installed on
your local machine. This is a one-time occurrence. However, the first time you edit a file through
TeamSitea , your browser may display a dialog asking you whether or not you want to give permission to
run the Launch Pad applet. If this dialog appears, click yes. Also, if you click the “Always trust” check
box, this dialog will not appear again.

Note: To change your TeamSite password, please contact a member of the Applications Support Team
who will update your password in Unix. There is currently no method to update your password through
TeamsSite.

IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002
Status: Final Page 28 Version 2.0



IFAP and Schools Portal Content Management
Functional Processes and Procedures

FIOELA
FTURERT AT

Setting your Home Page

IFAP/Portal Team
Sets their Home

Page
IFAP/Portal team sets NOTE: Your Home Page will be stored on the TeamSited Server.
their Home Page. You can change this setting at any time, or reset it to the default

setting (the default home page is the list of jobs you own).
In the TeamSitea GUI, navigate to the location or workflow
view that you would like to go to after logging in.
Click the Edit pull down menu
Click Set Home Page
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Completing Tasks

IFAP/Portal
Coordinator
Creates a Job

|

IFAP/Portal Team
Views Task / Job
in the To Do List

IFAP/Portal Team
Creates a New
Task

IFAP/Portal Team
Advises Content

"| Manager Task is

Completed

IFAP/Portal
Coordinator Views
Comments from
the Author

This section will cover the procedures to complete a Task. This area describes how the IFAP/Portal
coordinator will create a Job and the steps the contributor will take to view the Job. Next the contributor
will accomplish the Task and send their comments back to the IFAP/Portal team so they know the task
has been completed; the contributor can also provide additional comments for the IFAP/Portal
coordinator, if necessary. The last part of this section covers how the IFAP/Portal team will view the
contributor comments concerning the Task they completed and how to view all Tasks / Jobs listed in

TeamSite.
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IFAP/Portal coordinator
Creates a Job for the
FSA Employee.

Creating a Job in the To Do List

IFAP/Portal
Coordinator
Creates a Job

Log in as an Editor or Higher.
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.

Create the New Job

Click the File pull down menu

Select New Job

Click the Button next to the workflow template you want
to use (currently there is only one choice — Single
Approver)

Enter descriptive comments in the “Enter a Description
for the New Job” field

Click New Job

Select the username of the appropriate contributor. This
person will be the one formatting the content.

Enter a description of the job in the Task Description
field.

Enter the name of the Branch the job will be posted to in
the Enter Branch field (the name is IFAP).

Enter the name of the Workarea the job will reside in the
Enter Workarea field.

Select the username of the appropriate Reviewer in the
Content Approver field. This person will be responsible
for approving the content.

Click the Run Job button. The new job is created and
appears on the Content Contributor’s To Do List.

If the run job is rejected then ...... ( provide the rest of the
procedures. )

A L)
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- The Work Area Button should
be visible, the Work Area Button
has a Folder with a Pencil in the

Center and is located directly
below the Edit Pull Down Menu.

- A New Job Window will appear
asking you to select the
Workflow Template you want to
base the job on

- A New Job Template Window
will appear with different Pull
Down Menus and Fields

- Your Job is now entered in
TeamSite
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IFAP/Portal team views
their Task(s)/ Job in the
To Do list.

Viewing Tasks / Jobs in the To Do List

IFAP/Portal Team
Views Task / Job
In the To Do List

1. Login as an Author or higher and view the To Do List.
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.

2. To view information about the task
Click the Job Options pull down menu
Click Job Details
You can view additional information on any specific job
by clicking on the Description link (this link will contain
the job description followed by a job ID number in
parentheses. A new window will open displaying the job
details. To exit this window, press the Close button.
Press the Close button to exit the Job Details window.

For WebDesk Users:

1. Login as an Author or higher and view the To Do List
The task highlighted in blue on the top part of the
WebDesk screen is the one whose details are displayed
on the lower portion of the screen. The selected task is
highlighted in blue.

2. To Select a task

- Click in the Description. There are three tabs on the
lower half: Task Details, Task Files, and Task
Comments.
Select the desired tab by clicking on the name. The
current tab will appear in white, while the hidden tabs will
appear shaded.

The Task Files tab displays the files that are associated with
the Task. There are four options the user has in this tab:

The New Record button creates a new Data Record.

When this button is pressed, the user is prompted to
select a Data Record Template. After selecting the
correct template, press the OK button. The editor
appears, and edit the Data Record accordingly.

The New File button allows the user to create a file
(i.e. HTML, etc.) for the task. From the menu, select
the proper template and type file name in the New

- The To Do List displays two
Pull Down Menus: Task
Options, on the Left side of the
screen and Job Options, on the
Right side of the screen. These
menus allow you to obtain
further information on the Tasks
or Jobs

- A Job Details Window will
appear with the Job Details.

The current tab will appear in
white, while the hidden tabs
will appear shaded.
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File Name field. Press the Create button to create
the file.

The Attach Files button allows users to attach an
existing file to the task. Navigate to the directory the
file is located in and press the OK button to attach
the file.

The List Changes button lists the changes, if any, of
all the files related to the task. When done viewing
this window, press the Close button.
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IFAP/Portal Coordinator
changes the owner of a
specific task
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Changing the Owner of Tasks / Jobs in the To Do List

IFAP/Portal Team
changes the owner
of a Task / Job In
the To Do List

Log in as an Admin or higher and view the To Do List.
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.

To view and modify the owner of a task
Click the Job Options pull down menu
Click Job Admin

To change the owner of a task

Click the Select One pull down menu

Click Change Task Owner

In the Task Owner text box, type the name of the new
user you would like to own the task and click Change
Hit Close to exit the Job Admin window

- The To Do List displays two
Pull Down Menus: Task
Options, on the Left side of the
screen and Job Options, on the
Right side of the screen. These
menus allow you to obtain
further information on the Tasks
or Jobs

- A Job Details Admin window
will appear with the Job Details.

- A Change Task Owner dialog
box will appear with the current
owner of the task in the text box
- The Job Admin window will
reappear with the name of the
new owner next to the task
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IFAP/Portal team creates
a new task based on the
Content Managers
request.

4.

Creating a New Task

IFAP/Portal Team IFAP/Portal Team
Creates a New p Advises Reviewer
Task Task is Completed

Log in as an Author or higher and view the To Do List.
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.

Add a Existing File — Update instructions

Click the Task Options pull down menu

Select Start Task or Edit Task

Click the Select Task Operation pull down menu on the
right hand side of the window that appears

Select Add Existing File

Select the directory the file should reside in by clicking
the desired Directory folder. There may also be
subdirectories that appear after the main directory is
chosen (note — if you select a subdirectory and want to
move up to the main directory, select the yellow folder
with the up arrow).

Select the file from the Directory Contents window.

Type the File Name in the File Name field (The File
Name should not include the file extension such as .doc,
.Ixt, .html. etc.).

Click the OK button to create the file.

The next time you view the Task Detalils for this task, the
file you created will appear in the list of files associated
with the task.

PO ELA
STURERT 1D

- Your Tasks/ Jobs will be visible
and The Work Area Button will
be displayed directly below the
Edit Pull Down Menu

IFAP/Portal team
member advises the
Reviewer that the Task
has been completed.

Mark the Task Complete

From the To Do List, go to the Task Options selection
box next to the name of the task you want to mark as
completed.

Remove the Lock on the file(s)

Select Done from the list.

Type any comments you want to send the Content
Manager in the Transition Comment field

Click the Transition to Next Task button

- A TeamSite Task Transition
Window will be displayed
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Editing Files

IFAP/Portal Team

| Advises Reviewer

File has Been
Edited

IFAP/Portal Team
Edits a File

1. Login as an Author or higher
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.

IFAP/Portal Team edits
content file

2. Open the Task you want to Edit

- Click the Task Options drop down box next to the task
that contains the file you want to edit.
Click Edit File button on the toolbar or Edit File from the
Edit menu.
Maximize the LaunchPad window if it is minimized (it
should appear after selecting Edit File/Data Record
above). You can display the LaunchPad by selecting it
from the Windows Start menu bar.

NOTE: Which ever File Name Extension is used, the
associated application program will be opened (.doc
= Word, .xIs = Excel, .ppt = PowerPoint). If you want
to edit the file with a different application, select Edit
With instead of the Edit button.

3. The file will open in your editing application. Make the
necessary changes to the document.

4. Save and Close the document.
(note — LaunchPad keeps track of which directory the file
is located in, so you do not need to remember)
Maximize the LaunchPad Window if it is minimized.
Click once on the document you modified to highlight it
(note — if changes were made to the document, the icon
beside the filename will resemble a notepad with a pencil
on it)
Click the Upload button. You will be prompted to either
Remove or Keep a local copy of the file you are
uploading. Removing the file will delete the file from your
hard drive; while keeping the file keeps the copy on your
hard drive. Choose the desired option (note -if you
choose to keep the file, the icon next to the file changes
to indicate no changes have been made to the file, since
it is being uploaded to the workarea)
Close the TeamSite Launch Pad window by pressing the
Done button.

- Your Tasks /Jobs will be visible
and the Work Area Button will
be displayed directly below the
Edit Pull Down Menu. The To
Do List displays two Pull Down
Menus: Task Options, on the
Left side of the screen and Job
Options, on the Right side of the
screen

- The TeamSite LaunchPad
Window will be displayed with
your Document/s

- To edit a file NOT on your
Tasks/Jobs area, navigate to the
directory containing the file you
want to edit and click the check
box next to that file.

- Another TeamSite LaunchPad
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Window will be displayed
saying; Remove the Temporary
Local Copies After Uploading

- Closes the Task File Window

IFAP/Portal team
member advises the
Reviewer that the task
has been completed.

Mark the Task Complete
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.
Remove the Lock on the file(s)
Select Done from the list.
Type any comments you want to send the Reviewer in
the Transition Comment field
Click the Transition to Next Task button

- A TeamSite Task Transition
Window will be displayed

- Closes the Task Transition
Window
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Importing/Editing Files and Content not in TeamSite™

IFAP/Portal Team
Downloads File to -

be Edited

IFAP/Portal Team
Imports file into
TeamSite

» | IFAP/Portal Team
"] Edits a File o

IFAP/Portal Team
Advises Reviewer

File has Been
Edited

IEAP/Portal Team 1. Conne<_:t to the WWW and determine which page you A save file dlalpg box. Mal_<e
: would like to edit. sure to save the file to a location
downloads file to be : ' ;
: Choose File>Save As and save the file as an htm or you will remember.
edited ;
html file type.
Import the files into 2. Find the location you would like to save the file in apgegmreﬂg?;l;ﬁr?é;bbrg)\;v\;vgIto
Teamsite to edit content 3. Import the file the location of the file you wish to
From the menu bar, select File>Import upload
Browse to the location of the file you wish to upload and
select the file and select the Add button - Your file will appear in the
Click the Import button to import all files to TeamSite “FilePath” box below that you will
be uploading
Edit Content 4. Open the content you want to Edit - Your Tasks /Jobs will be visible

Find the location of the file you have just imported

Click Edit File button on the toolbar or Edit File from the
Edit menu.

Maximize the LaunchPad window if it is minimized (it
should appear after selecting Edit File/Data Record
above). You can display the LaunchPad by selecting it
from the Windows Start menu bar.

NOTE: Which ever File Name Extension is used, the

associated application program will be opened (.doc
= Word, .xIs = Excel, .ppt = PowerPoint). If you want
to edit the file with a different application, select Edit
With instead of the Edit button.

The file will open in your editing application. Make the
necessary changes to the document.

Save and Close the document.

(note — LaunchPad keeps track of which directory the file
is located in, so you do not need to remember)

Maximize the LaunchPad Window if it is minimized.

Click once on the document you modified to highlight it
(note — if changes were made to the document, the icon
beside the filename will resemble a notepad with a pencil
on it)

Click the Upload button. You will be prompted to either
Remove or Keep a local copy of the file you are
uploading. Removing the file will delete the file from your
hard drive; while keeping the file keeps the copy on your

and the Work Area Button will
be displayed directly below the
Edit Pull Down Menu. The To
Do List displays two Pull Down
Menus: Task Options, on the
Left side of the screen and Job
Options, on the Right side of the
screen

- The TeamSite LaunchPad
Window will be displayed with
your Document/s

- To edit a file NOT on your
Tasks/Jobs area, navigate to the
directory containing the file you
want to edit and click the check
box next to that file.
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hard drive. Choose the desired option (note -if you
choose to keep the file, the icon next to the file changes
to indicate no changes have been made to the file, since
it is being uploaded to the workarea)

Close the TeamSite Launch Pad window by pressing the
Done button.

- Another TeamSite LaunchPad
Window will be displayed
saying; Remove the Temporary
Local Copies After Uploading

- Closes the Task File Window

IFAP/Portal team
member advises the
Reviewer that the task
has been completed.

Mark the Task Complete
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.
Remove the Lock on the file(s)
Select Done from the list.
Type any comments you want to send the Reviewer in
the Transition Comment field
Click the Transition to Next Task button

- A TeamSite Task Transition
Window will be displayed

- Closes the Task Transition
Window
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Create a New Data Record

IFAP/Portal Team
| Advises Reviewer
" Data Record has
been Created

IFAP/Poprtal
Team Creates a
New Data Record

IFAP/Portal team . Login as an Author or higher

memeber completes a - To see which tasks and jobs you own that are currently - Your Tasks/ Jobs will be visible

New Data Record. pending, click the To Do button in the Button Bar. You and the Work Area Button will
can also select the To Do List option in the View pull be displayed Directly Below the
down menu. Edit Pull Down Menu .

2. Creating the New Data Record

- Click the Task Options pull down menu next to the job
you want to create the Data Record in - A TeamSite Task Details
Select Start Task or Edit Task Window will be displayed
Click the Select Task Operation pull down menu on the
right side of the screen
Click New Data Record - A New Data Record Window
Navigate through the directories on the “Select a will be displayed
category and type” screen to select the template type you
wish to use for this Data Record. When the desired
template appears in the “Template Type” box, press the
OK button.
At this point, you may be prompted to install
VisualFormat (the installation is a one-time occurrence).
If this screen appears, follow the on-screen instructions
to install the program.
The selected Data Record template will appear on the
screen. Each template will differ in various ways, but the
basic features are the same: there is a navigation pane
on the left-hand side of the window that allows you to
quickly move to the part of the DCR you want to. The
right hand side of the window contains the data for the
DCR.
Type your information in each Field

NOTE: There are Five options at this point (Save, Save As,
Preview, Generate, and Close).

3a. By clicking Save, your New Data Record will be saved
and displayed by which Template you choose

3b. By clicking the Save As, your New Data Record will be
saved with the name you give to it at the prompt.

3c. The Preview button will display a preview of the
document being created in the browser. You must save the
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file before previewing it.

3d. The Generate button will generate the HTML document
from the DCR data entered. The record must be saved
before generating the HTML document.

3e. The Close button closes the current window without
having to save change made.

FIOELA
FTURERT AT

IFAP/Portal team
memeber advises the
Reviewer the New Data
Record has been
Completed.

Mark the Task Complete
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.
Remove the Lock on the file(s)
Select Done from the list.
Type any comments you want to send the Reviewer in
the Transition Comment field
Click the Transition to Next Task button

- A TeamSite Task Transition
Window will be Displayed

- The next task is displayed
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Viewing Comments From An Author or Higher

IFAP/Portal Team
Views Coments
From The Author

IFAP/Portal Team views Log on as an Editor or Higher
comments from the - Click the To Do Button if the Tasks are not displayed
Author. Click the Job Options pull down menu on the right side
of the screen

Select Job Details - A Job Details Window will be

displayed with the Authors
Comments

Click the Close Button when finished viewing comments

Viewing All Jobs

IFAP/Portal Team
Views Available
Jobs

View all available jobs.

Log on as an Author or Higher

Click the To Do Button if the Tasks are not displayed - Alist of All Jobs on TeamSite
(note — You can also select the To Do List option from will be displayed (there may be
the View pull down menu) jobs that are not IFAP-related)
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Locking and Unlocking Files Using Submit Locking

Locking Files
Using Submit
Locking

Unlocking Files

This section covers how to Lock Files using Submit Locking and how to Unlock files. TeamSite supports
three different types of File Locking: 1) Submit Locking, 2) Optional Write Locking, and 3) Mandatory
Write Locking. TeamSite is configured to support only Submit Locking so you won't have to execute
Optional Write Locking and Mandatory Write Locking. Submit Locking allows only the user who locks the
file to submit it to the Staging Area. Other users are allowed to edit a locked file in their Work Area,
however, the user who holds the lock must release (i.e. unlock) it before it can be submitted to the

Staging Area.
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HOW TO LOCK FILES
USING THE SUBMIT
LOCKING METHOD.

Locking Files Using Submit Locking

Locking Files
Using Submit
Locking

NOTE: You must be an Editor or Higher to Lock Files

Log in as an Editor or Higher
To see which tasks and jobs you own that are currently
pending, click the To Do button in the Button Bar. You
can also select the To Do List option in the View pull
down menu.

NOTE: Make sure you are in your Work Area by clicking the
Work Area button

Navigate to the Directory where the file is located that
you want to lock

Click the Checkbox next to the name of the file

Click the Edit pull down menu

Select Lock

Type any comments you have in the Comments field.

NOTE: The Lock Function will automatically compare the
version in the Work Area and the version in the Staging Area
(if there is a version in the Staging Area) and take the most
recent.

If you want to keep the version in your Work Area,
whether or not it is newer, deselect the Get Latest
checkbox

Click the Lock button

- The Work Area Button should
be visible, the Work Area Button
has a Folder with a Pencil in the
center and is located directly

below the Edit Pull Down Menu.

- An Enter Lock Comments
Window will appear.

- TeamSite will lock the File(s)
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Unlocking Files

Unlocking Files

How to Unlock Files. NOTE: You must be an Editor or Higher to Unlock Files
Log in as an Editor or Higher
- To see which tasks and jobs you own that are currently - The Work Area Button should
pending, click the To Do button in the Button Bar. You be visible; the Work Area Button
can also select the To Do List option in the View pull has a Folder with a Pencil in the
down menu. center and is located directly

below the Edit Pull Down Menu.
NOTE: Make sure you are in your work area by clicking the
Work Area button

Click the directory where the file is located that you want
to unlock

Click the checkbox next to the file/s you want to unlock
(note — a locked file will have a picture of a key in the
icon next to the file name) - The File/s are Unlocked
Click the Edit pull down menu
Select Unlock
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Approving / Rejecting and Deleting Content

IFAP/Portal Team/
Content Manager
Deletes Content

Reviewer Reviewer Rejects
Approves Content Content

This section covers the procedures for the Reviewer to Approve or Reject the Task. This section will also
show how to delete content.
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Approving Content

Reviewer
Approves Content
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Reviewer approves Log in as an Editor or Higher

tasks. Click To Do Button if the Tasks are not displayed

Click the Task Options pull down menu next to the job
that awaits approval

Select Approve
Type your comments in the Transition Comment field
Click the Transition to Next Task button (note —

pressing this button will send the documents to the
staging area)

- A Task Transition Window wiill
be displayed
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Rejecting Content

Reviewer Rejects
Content

Reviewer Rejects tasks. Log on as an Editor or higher
- Click the To Do button if the tasks are not displayed
Click the Task Options pull down menu
Click Reject - A Task Transition Window will
Type your comments in the Transition Comment field be displayed
Click the Transition to Next Task button (note — the
Author can now log in and view the comments made by
the reviewer. The rejection should appear as another
task with a separate ID)
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Removing Files from Workarea

IFAP/Portal Team
Deletes File from
Workarea

Log on as an Author or Higher

Enter your work area
Navigate to the directory where the file is located

IFAP/Portal Team
Member Removing

Files from Workarea :
- Click the checkbox next to the File/s you want to delete in
your work area (note — you can check more than one file
to delete)
Click the File pull down menu
Click Delete ] ] )
Click the OK button if you want to delete the file - A Window will appear asking
you to Delete Selected File, Are
NOTE: The list of files in your work area will be updated to | YOU Sure?
reflect the deletions. If the files are not updated, click the
Refresh button.
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Removing Files from Staging

IFAP/Portal Team
Deletes File from
Staging
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IFAP/Portal Team
Member Removing
Files from Staging

Log on as an Author or Higher

- Make sure you have deleted the files from your work
area (See “Removing files from Workarea”)
List modified files in that workarea. The deleted file in
your workarea will have a deleted files icon (a document
with a red X over it).
From the list of modified files, select the deleted file.
Click the Submit button on the toolbar, or select
File>Submit.

NOTE: The list of files in your work area will be updated to
reflect the deletions. If the files are not updated, click the
Refresh button.

- A Window will appear asking
you to Delete Selected File, Are
You Sure?
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3.0 Definitions

Administrator — The owner of a branch, responsible for the project being developed on it. An
Administrator can perform all the functions that an Author or an Editor can, and can also create and
delete new sub-branches and workareas on that branch. Administrators exercise control over workflow
by giving workareas to editors and sub-branches to other administrators.

Author — A primary web content contributor with limited access to the TeamSited system. Authors can
access, create, and modify web content through their Editors’ workareas. An Editor can assign specific
files to an Author, which will appear in the Author’s To Do list.

Branch - a path of development for a body of content developed and maintained by a team. Each branch
contains one or more work areas, a staging area, and a published edition and may contain sub-branches
and previous editions. When entering branch information, it must always be “ifap”. Note: Interwoven is
case sensitive.

Comment - A note attached to a file, directory, work area, branch, edition, job, or task. Comments can
be attached to work areas, branches, and editions when they are created. Comments can be attached to
files and directories when they are assigned, returned, rejected, locked, or submitted. Global comments
can be set when these functions involve multiple files.

Compare - A function that displays a list of the differences between any two TeamSite objects. Objects
that can be compared include work areas, staging areas, or editions.

Conflict - Occurs when multiple users make changes to the same file in multiple locations, e.g. when a
file had been changed in two different work areas.

Conflicting Edits - Occur when multiple users make changes to the same parts of the same file,
producing two versions of the file that cannot be automatically merged. Conflicting edits require users to
specify which individual changes will go into the merged version.

Content Contributor- Ideas are formulated within the business units by Content Contributors. The
Content Contributor documents his/her idea in the appropriate format for the Content Manager in his/her
business unit.

Content Manager- Content Managers will review and approve the content and send an email request to
the Schools Channel Customer Service Call Center. The Content Manager provides a description of the
work to be done and attaches any necessary files to the email.

Edition - A frozen, read-only snapshot of a branch of development. An edition contains a copy of all the
files in the staging area at the time it was published. New editions can be released to production servers
as complete, functional websites. Editions also serve as rollback points for projects in development, and
they provide back archives of the website.

Editor - Editors own work areas within their channel’s sub-branch. They can create and edit content, just
as Authors do, but they are primarily responsible for managing the development taking place within their
work areas. Editors are generally “managerial” users, who primarily supervise the work of Authors, or
self-managing “power” users, who need additional functionality to manage their own content.

History - A complete record of all changes that have been made to a file through time. A user can see
the complete history of a file by selecting it and selecting History from the View menu.
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Home Page - A user’s overview of the TeamSite system. By default, an Author's Home Page will display
his / her Task list. An Editor's or Administrator's Home Page will display an overview of the TeamSite
system. The Home Page can be set to any directory where the user has access.

IFAP/Portal Coordinator- receives email requests from Content Managers, prioritizes these requests
and assigns the requests to an IFAP/Portal Team Member.

IFAP/Portal Team Member- Any user of TeamSite that creates or modifies content for the website.

Initial Edition - The first edition on a newly created branch. The initial edition serves as the original
source of content for all work areas on a new branch. This edition may be empty, or it may be a copy of
an edition from another branch.

Job - A set of interdependent tasks. Each job is a specific instance of a workflow model.

Locking - Restricting file assess within a branch. Locking a file reduces the possibility of conflicting edits
but also reduces the team’s ability to work on files simultaneously. Every time a file is locked, the version
in the work area is compared with the version in the staging area and the latest is taken. TeamSite
supports three types of locking, or locking models: Submit Locking, Optional Write Locking, and
Mandatory Write Locking. The locking model is defined at the branch level by the Administrator. Submit
Locking is the only available locking model for FSA unless the Administrator changes this locking model.

Main Branch - The first branch created when TeamSite is installed. The Master owns the main branch.
All branches in the TeamSite system are subordinate to the main branch.

Master - The owner of the main branch. The Master user’s is responsible for the entire Web site. The
Master organizes the structure of the TeamSite and coordinates the activities of all users’, and can also
perform all functions on all branches.

Merge - The process of reconciling conflicts between versions of a file that have been edited by two
people. The two versions can be merged in the staging area to produce a new version of the file,
incorporating changes made by both users. Merging can be automated with TeamSite’'s Advanced File
Merging.

Navigation Window - The left-hand side of the TeamSite window, which allows you to navigate through
TeamsSite by clicking on the underlined names of branches, work areas, staging areas, editions, or
directories.

Open Deploy - Allows the transfer of website content from the development server to the production
server.

Publish - To create a new edition based on the current staging area.

Reviewer- This person will be responsible for approving or rejecting the content after it is created or
updated.

SmartContext - The use of individual work areas and staging areas to allow user’s to test their work in
the context of the entire website without actually deploying the website. This allows Authors, Editors, and
Administrators to catch and fix their own mistakes at an early stage.

SmartContext Editing - The ability to edit a file while browsing the website. This provides a simple,
intuitive way of finding the file your want to edit, editing it in context and see your changes immediately.

Staging Area - The area where users integrate the contents of work areas. User’'s submit read-only
copies of files from their work areas to the staging area to integrate with other contributions, and test the
integrity of the resulting entire website.

IFAP Portals Content Management Processes V3.0.doc Last Updated:4/25/2002
Status: Final Page 52 Version 2.0



IFAP and Schools Portal Content Management
Functional Processes and Procedures

Submit - The act of transferring website content form a work area to the staging area.

Task - A unit of work performed by a single user or process. Each task in a job is associated with a
particular TeamSite work area and carries a set of files with it.

TeamSite Templating - A TeamSite module that allows you to configure the look and feel of your Web
pages.

Template - A file that specifies attributes of another file, such as look and feel. When you create a file,
you can choose to base that file on a template.

To Do List - A user’s initial view of the TeamSite system. The To Do List shows the user which tasks and
jobs he / she is responsible for, and allows the user to do the necessary work to complete the tasks.

User - A TeamSite Author, Editor, Administrator, or Master.

Work Area - a virtual copy of a website, which may be worked on independently without affecting the
actual site or the work of other contributors.

Workflow - A system for defining the necessary processes for content creation and approval.

Work Window - The right-hand side of the TeamSite screen, which allows you to navigate and
manipulate files within TeamSite.
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4.0 Using WebDesk

A user can log into TeamSited using the WebDesk interface. WebDesk is only available to users who log
in as Authors; and the functionality is the same as if logged into the normal interface. The following are
instructions on how to perform the various tasks using WebDesk.

Logging Into TeamSited

From the Login screen, enter your Username, Password, and select Author as your “Login as” type.

Check the WebDesk checkbox and press the Login button.

Viewing Tasks/Jobs

The WebDesk interface is a split-screen view that displays all the tasks the user owns on the top half of
the screen; while the details for a given task are displayed on the bottom half of the screen.

The task highlighted in blue on the top part of the WebDesk screen is the one whose details are displayed
on the lower portion of the screen. The selected task is highlighted in blue. To select a task, click in the
Description. There are three tabs on the lower half: Task Details, Task Files, and Task Comments.
Select the desired tab by clicking on the name. The current tab will appear in white, while the hidden tabs
will appear shaded.

The Task Details tab displays the following information:
The Task Description
The Task Name
The Workarea the task resides in
The Task ID Number
The Job Description that the Task is linked to
The Task Owner
The creator of the Job that the Task is linked to
The Job ID Number the Task is linked to

The Task Files tab displays the files that are associated with the Task. There are four options the user
has in this tab:

- The New Record button creates a new Data Record. When this button is pressed, the user is
prompted to select a Data Record Template. After selecting the correct template, press the OK
button. The editor appears, and edits the Data Record accordingly.

The New File button allows the user to create a file (i.e. HTML, etc.) for the task. From the menu,
select the proper template and type file name in the New File Name field. Press the Create
button to create the file.

The Attach Files button allows users to attach an existing file to the task. Navigate to the
directory the file is located in and press the OK button to attach the file.

The List Changes button lists the changes, if any, of all the files related to the task. When done
viewing this window, press the Close button.

The Task Comments tab allows users to add a comment to the task. To add a comment, type the
desired comment in the space beneath the Add Comment button. When finished, press the Add
Comment button.
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Viewing Workareas

The Files tab on the top of the screen allows users to view their workareas. Selecting the Files tab
brings up a view similar to the workarea view in the normal interface view. There are four buttons to
choose from: Browse, File, View, and Submit. The Browse, File, and View buttons contain similar
commands as the drop down menus of the normal TeamSiteéd interface; while the Submit button
performs the same function as the Submit command in the normal interface.

Miscellaneous ltems

The following is a list of miscellaneous items found in the TeamSited WebDesk interface:
The Logout button is located near the upper right-hand corner of the browser.
The Refresh button is located near the upper right-hand corner of the browser, next to the
Logout button. When refreshing, use this button, not the browser button on the Web Browser
toolbar.
The Add to Favorites button acts similar to a bookmark. If you are working in a specific directory
and want to return to that area upon logging on again, pressing this button will bookmark the
directory; and you will return to that directory when you log in next time.
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